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1 Introduction

1.1 About this Document

This installation guide describes the steps required to install or upgrade Plant Connectivity (PCo) Release 15.1
with support package 03. It specifies the sequence of installation activities and their dependencies.

1 Note

PCo Release 15.1 is the successor version of PCo Release 15.0.

1 Note

The term “Installation” in this guide is also valid for an upgrade of Plant Connectivity. If there are additional
steps to be taken into consideration, or steps that differ from the initial installation procedure, this will be
mentioned separately in this guide.

The target groups are:

® System administrators

® Technical consultants

® Application consultants

® Project team members

PCois delivered as an installation package that enables you to perform a complete or custom installation.
® The complete installation includes all PCo components.

® The custom installation allows you to choose the specific components that you want to install, for example,
selected source systems.

You can install only one instance of PCo on a single Windows machine.
The installation includes the following components:
® PCo core components

o Management Console

o Management Service

o Connectivity Framework

©  Remote Client (for MMC — Microsoft Management Console)
® PCo agents

o CitectSCADA (Schneider Electric)

o File Monitor

©  File System

o |P21-InfoPlus.21 (AspenTech)

©  Modbus
o ODBC
o OLEDB
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o OPCA&E
o OPCDA
o  OPCHDA
o OPC-UA

o Pl Historian (OSlsoft)

o Pl Asset Framework (OSlsoft)

o Proficy Historian (General Electric)

o Socket

PCo destination systems

o MIl destination system

o RFC destination system (SAP EWM, Business Suite, SAP ODA Replacement)
o Simulation destination system

o Web service destination system (SAP ME)

o RESTful Web service destination system

o OData destination system

o Universal Web service destination system

o Data streaming destination system (SAP ESP system)
o ODBC destination system

o OPC UA destination system

o Multiple Call destination system

o Query destination system

WebSocket server

OPC UA server

Publisher Policy (for assembly binding redirection)

PCo agent SDK (available only if Visual Studio 2012 or higher is installed)
MSMQ Integration

During installation, you can select the components that you want to install.

Note

The destination systems are now part of the PCo core components and will always be completely installed.

1.2

Before You Start

The following information must be taken into consideration before starting the installation.
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1.3 SAP Notes for the Installation

Table 2

2166275 A Release Installation Note for PCo 15.1 Up-to-date information on PCo 15.1
Service Pack 00 (SPOO) installation

2235901 A Release Installation Note for PCo 15.1 Up-to-date information on PCo 15.1
Service Pack 01 (SPOL) installation

2270998 s Release Installation Note for PCo 15.1 Up-to-date information on PCo 15.1
Service Pack 02 (SP02) installation

2328278 A Release Installation Note for PCo 15.1 Up-to-date information on PCo 15.1
Service Pack 03 (SPO3) installation

1.4 Naming Conventions

In this documentation, the following naming conventions apply:

Table 3
<INSTDIR> Installation directory for the PCo installation (for example,
|» C:\Program Files » SAP » Plant Connectivity 3 (ona 32-
Bit operating system)
<Date> Date (for example, 2011.01.17 or 2011_Jan_20)
<Time> Time (for example, 08:00:00 or 08.00.00 - used in file
names)
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Planning

PCo runs on the following operating systems:

Microsoft Windows Vista (32-bit)
Microsoft Windows 7 (32-bit)
Microsoft Windows 7 (64-bit)

Microsoft Windows Server 2008 (32-bit or 64-bit), with PCo running in 32-bit mode on 64-bit operating
systems

Microsoft Windows Server 2008R2, with PCo running in 32-bit mode on this 64-bit operating system
Microsoft Windows 8 and 8.1 (64-bit), with PCo running in 32-bit mode on this 64-bit operating system

Microsoft Windows 2012 (64-bit) and Server 2012 R2 (64-bit), with PCo running in 32-bit mode on this 64-bit
operating system

Microsoft Windows 10 (64-bit) and Server 2016 (64-bit), with PCo running in 32-bit mode on this 64-bit
operating system

Note

For more information, see the PCo Security Guide at service.sap.com/instguides .

If you are carrying out an upgrade, the following applies:

8

You can upgrade from any previous version of PCo directly to PCo 15.1.

All existing agent instances and settings remain intact and can be migrated automatically if necessary. It is,
however, strongly recommended to export all your agents before you upgrade your installation. If you already
run an earlier version of PCo 15.1, you should also create a backup of the configuration by choosing [F Plant
Connectivity » Backup 1 from the menu of the PCo Management Console.

Caution

Automatic migration does not take place if you use agents you have developed yourself or agents from
third parties that were developed using the Software Development Kit, or developments of your own, or
products from third parties that reference certain PCo assemblies. In this case an assembly binding
redirection has to be set up. This can be done automatically if you select the checkbox Publisher Policy in
the Installation Program (see section 4.2 Upgrade Installation).

For more information about assembly binding redirection, see SAP Help Portal at |[» help.sap.com/ # »
SAP Business Suite » SAP Manufacturing » SAP Plant Connectivity » PCo 15.1 » Application Help » SAP
Plant Connectivity » Version Conflicts with strong-named PCo Assemblies 3

Because all agent instances and the Management Console need to be stopped for the upgrade, it is
recommended to plan some downtime for each PCo upgrade (minimum 15-30 minutes).

Note that notification message queues cannot be migrated. All notification messages queues and the
notification messages contained within will be deleted during an upgrade. Make sure that all relevant
notification messages have been processed successfully, before you perform an upgrade
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3 Software Download

The software installer for SAP PCo can be downloaded from the SAP Service Marketplace. Make sure that you
download the software under |» Software Downloads » Support Packages and Patches 1 in order to obtain a
version that includes the newest support packages and patches. SAP recommends that all users of SAP Plant
Connectivity 15.1 import the latest available support package because, in addition to the patches that have already
been published, it always contains a large number of minor corrections and improvements.

The software installer for PCo is self-contained. You can use the installation program for the latest support
package or patch to update a PCo version that is already installed or to set up a new installation if PCo is not yet
installed on the target computer.

If you plan to make the documentation for PCo available offline on computers that do not have access to the
public Internet you should download the documentation file as well. You can find the archive with the available
offline documentation under |» Software Downloads » Installations and Upgrades » A-Z Index » P » SAP Plant
Connectivity » SAP Plant Connectivity 15.1 » Application Help (SAP Library) 1.

CUSTOMER
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4 Preparation

Before installing PCo, you must carry out the following preparatory steps for the operating system you are
installing on and the type of agents you want to install. Please also check these steps if you are carrying out an
upgrade.

4.1 Microsoft Preparation Steps

You must observe the following installation steps for Microsoft operating systems:
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.NET Installation

Before installing PCo, you must install Microsoft .NET Framework Version 4.5.2. Any higher version of
the .NET Framework also suits the requirement. For more information, see www.microsoft.com # .

Windows Services
The following Windows Services are used:
©  Net.TCP Port Sharing Service
You have to set the Microsoft Windows Net. TCP Port Sharing Service to Automatic startup type.

Caution

By default, this service is disabled and makes the Management Host service of PCo inoperable.

o OPCEnum

If you are installing the classic OPC source systems (OPC DA, OPC HDA or OPC A&E), the service
settings of OPCEnum also have to be set to Automatic. If it has not already been started, you must start
the service manually.

Windows 7 and 8 Security Options

If you are installing PCo on Windows 7or 8, you need to set the security optionNetwork Access: Let everyone
permissions apply to anonymous users to enabled under the following path:

Ik Control Panel » System and Security » Administrative Tools » Local Security Policy » Local Policies ¥
Security Options 1.

Microsoft Message Queuing (MSMQ)

As of PCO 2.3, the Windows component Microsoft Message Queuing (MSMQ) is being used to send
notification messages within the notification scenario. For more information about MSMQ, see
msdn.microsoft.com/en-us/library/ms711472(v=VS.85).aspx #* .

With PCo 15.1.3 this feature has been made optional and can be selected as an additional component during

installation. This component includes the activation of the MSMQ feature and the required assemblies to
support this MSMQ queuing mechanism in PCo.
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Caution

When you install PCo 15.1.3 as an upgrade installation over an existing PCo version, make sure, that the
MSMQ component is selected so that your agent instances remain functional. If the installation of this
component was missed, execute the installer again and select the component for installation.

If the activation of the MSMQ feature of Windows failed, you can also install MSMQ manually by executing the
MSMQInstallUtil.exe filein PCo's installation directory.

To check whether MSMQ has been installed on the computer on which PCo is running, do the following:
o Windows 8 and Windows Server 2012

Search for the Control Panel on the Start menu, then choose | Control Panel » All Control Panel Items »
Programs and Features 1.

In the menu on the left, click on Turn Windows features on or off.
Windows displays the Windows Features dialog box.

Check whether the Microsoft Message Queue (MSMQ) Server Core component has been installed. If it
has been installed, the Microsoft Message Queue (MSMQ) Server Core entry is selected.

o Windows 7
Choose |r Control Panel » All Control Panel Items » Programs and Features 3.
In the menu on the left, click on Turn Windows features on or off.
Windows displays the Windows Features dialog box.

Check whether the Microsoft Message Queue (MSMQ) Server Core component has been installed. If it
has been installed, the Microsoft Message Queue (MSMQ) Server Core entry is selected.

©  Windows Server 2008
Choose |r Control Panel » Programs and Features 1.
In the menu on the left, click on Turn Windows features on or off.
Windows displays the Server Manager dialog box.
Choose the Features entry. Choose the Select Features pushbutton.

In the Add Feature Wizard dialog box, the Message Queuing, Message Queuing Services, and Message
Queuing Server entries must be selected.

4.2 Upgrade Preparation Steps

Before starting an upgrade, you must stop all agent instances. Make sure that all notification messages have been
processed, since notification messages queues will not be migrated to the next release. During upgrade to PCo
15.1 the database logs of the agents will be replaced with Windows Event Logs. If you need to keep the log entries
of your agents, export the logs by using the pertaining function on the Log tab of the PCo Management Console
before the upgrade.

* exe.config files are overwritten in an upgrade to PCo 15.1.3. This affects the ManagementHost.exe.config
and ManagementConsole.exe.config filesin particular. If you have adapted these files and want to retain the
changes, you should save your changes before an upgrade. You need to reinsert the tags, which you added
manually, in the newly installed config files.

CUSTOMER
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1 Note
Note the following if there are changes to the configuration files:

The changes to these settings delivered with earlier releases were forced by the transition from older .NET
versions to .Net 4.5.2 and are technically necessary, or they are caused by the SAP product standard Security.

Finally, close the PCo Management Console. Then carry out the upgrade installation as described below.
Ensure that your system has no pending reboots, for example, due to the installation of Windows security

patches. If there are pending reboots due to a Windows Update or if SAP Setup informs you about a pending
reboot, perform the reboot before proceeding with the installation.

1 Note
It is strongly recommended to export all agents instances before starting an upgrade. Additionally, you should
perform a backup of the PCo configuration.
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Installation

The installation procedure differs, depending on whether you are carrying out an initial installation or an upgrade.
If PCo is already installed, and you want to carry out an upgrade, please follow the instructions in the next section
(“Upgrade Installation™).

51

Toin
1.

N o ok

Initial Installation

stall Plant Connectivity (PCo), proceed as follows:
Run the PCo installation program.

The SAP NetWeaver Front-End Installer Welcome dialog appears.

Caution

If the dialog informs you about a pending reboot, perform the reboot first before proceeding with the
installation.

Choose Next.
Choose Select All to install all components.

To select or deselect specific components, expand the PCo node and choose only the components that you
want to install.

1 Note

Publisher Policy is not needed for initial installations. You have to deselect the Publisher Policy checkbox.

Choose Next.
Confirm the installation directory or change it using the Browse pushbutton.
Choose Next. Product installation starts.

After installation has finished, choose Done.

5.2 Upgrade Installation

Procedure
To install Plant Connectivity (PCo), proceed as follows:
1. Runthe PCo installation program.
The SAP NetWeaver Front-End Installer Welcome dialog appears.
CUSTOMER
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Caution

If the dialog informs you about running PCo services or programs, stop all agent instances and the
Management Console before proceeding. You will not be able to continue with the upgrade installation
otherwise.

Choose Next.

Choose Select All to install all components. This will also flag newly available PCo components for installation.
To select or deselect specific components, expand the PCo node and choose only the components that you
want to install. Note that new components are not selected by default in an upgrade installation.

Caution

When you install PCo 15.1.3 as an upgrade installation over an existing PCo version, make sure that the
MSMQ component is selected so that your agent instances remain functional. If the initial installation of
this component was missed, execute the installer again and select the component for installation.

1 Note

The PCo destination systems are now part of the PCo core components and are always completely
installed. They can no longer be selected individually during installation.

4. If you are using custom agents, make sure that the checkbox for component Publisher Policy is selected.

1 Note

As of release PCo 2.3, to resolve version conflicts for custom agents, publisher policy files are available that
specify a redirection of the binding to the current version of the strong-named assemblies. This is only
relevant if you use your own agents or agents from third parties that were developed using the PCo
Software Development Kit in Release 2.2, or developments of your own, or products from third parties that
reference PCo assemblies from Release 2.2. If you upgrade from PCo 2.3 or later and all your custom
agents were created with PCo 2.3 or later you do not have to install the publisher policy. For more
information about assembly binding redirection, see SAP Help Portal at |p help.sap.com/ # » SAP
Business Suite » SAP Manufacturing » SAP Plant Connectivity » PCo 15.1 » Application Help » SAP Plant
Connectivity » Version Conflicts with strong-named PCo Assemblies 1.

5. Choose Next.
Product installation starts.

6. Afterinstallation has finished, choose Done.

1 Note
PCo does not support downgrading to a previous version of the application. If you want to return to an
older version of PCo after the upgrade follow the instructions in SAP Note 2232528 .
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6 Post-Installation

6.1 PCo Agent Preparation Steps

You must observe the following steps for the Plant Connectivity agents after installing PCo.

o (Citect agent

1. Copy the files for the CtApi interface from the Citect installation directory into the PCo system directory

(for example, to c:\Program Files (x86)\SAP\Plant Connectivity\System):

o ctapidll
o ct_ipc.dll
o cteng32.dll
o ctres32.dll
o ctutil32.dll

2. If PCois notinstalled on the same machine as Citect you have to set the following in the CitectSCADA

configuration file (citect.ini):
[CTAPT]
Remote=1

e |P21 Agent: To use the IP21 agent, carry out the following steps:

1. Ensure that a valid Windows user exists at the PCo machine and the IP21 database machine.

2. Copy the following files for the DBApi interface from the IP21 installation directory into the PCo system
directory (for example, c:\Program Files (x86)\SAP\Plant Connectivity\System):

o  cimsrvapi.dll

o CimWin32Util.dll

o infoplus21_api.dll

o ip2ladmin_client.dll
o ip2lezrpcw32.dll

o ip2lwinrpc32.dll

o libc2l.dll
3. Everytagin P21 that you want to use with PCo needs to have the following fields:
o |P_VALUE

o |IP_VALUE_TIME

o IP_VALUE_QUALITY

o |P_#_OF_TREND_VALUES
°o |IP_TREND_VALUE

o |IP_TREND_QSTATUS

o IP_TREND_QLEVEL

© |IP_DESCRIPTION

°© |P_GRAPH_MINIMUM
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o IP_GRAPH_MAXIMUM
ODBC Agent

If you want to use the ODBC agent, you first have to install and configure the ODBC driver for your data
source using the Windows tool ODBC Data Source Administrator. For more information about the ODBC Data
Source Administrator, see the PCo documentation under |+ SAP Help Portal » Enterprise Management »
Manufacturing » SAP Plant Connectivity » PCo 15.1 1.

OLE DB Agent: If you want to use the OLE DB agent, you must install MDAC 2.8.

OPC Agents: If you want to use OPC A&E, DA or HDA agents you must install the OPC core components 3.0
redistributable. Depending on the type of agent, you only can connect to servers that fulfill certain
specifications:

©o If youwant to use the OPC A&E agent, you can only connect to:
o OPC A&E server compliant with version 1.10 of the OPC A&E specifications
© If you want to use the OPC DA agent, you can only connect to:
o OPC DA server compliant with version 2.05a or 3.0 of the OPC DA specifications
o Ifyouwant to use the OPC HDA agent, you can only connect to:
o OPC HDA server compliant with version 1.20 of the OPC HDA specifications
© If you want to use the OPC UA agent, you can only connect to:

o OPC UA server compliant with version 1.0 of the OPC UA specifications

1 Note

The mentioned servers could be installed locally on the same computer or on a remote computer.

Pl Agent: If you want to use the OSlsoft Pl agent, you must install PI SDK Version 1.3.6 or later.

Asset Framework Agent: the asset framework (Pl AF Client(x86)2014) from OSlsoft Pl has to be installed in
version 2.6.0 or higher

Proficy Agent: If you want to use the Proficy Historian agent, you must install Proficy Historian SDK.

6.2 Checks

Procedure

To check your PCo installation, proceed as follows:

1.
2.
3.
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Start the PCo Management Console in the Windows start menu.

The Plant Connectivity Management Console screen appears.

To check whether all installed agents (source systems) are available, proceed as follows:

1. Start creating a new source system under the PCo menu: |» File » New » Source System 1.
2. Openthe drop-down list of source system types.

3. Check whether all the source system types are available.

4. Click Cancel (close the popup).

Check whether all installed destination systems are available:

1. Start by creating a new destination system under the PCo Menu: |» File » New » Destination System 1.

CUSTOMER
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2. Openthe drop-down list of destination system types.
3. Check whether all destination system types are available.
4. Click Cancel (close the popup)

5. Check whether the startup type of the PCo standard services suits your needs. The Management Host service
is installed by default with startup type Manual, the Active Monitor service with startup type Automatic.
Execute the following steps to change the startup type:

1. Typewindows-R to open the Run dialog

2. Enter services.msc to start the Services list in the Microsoft Management Console

3. Look up the pertaining SAP Plant Connectivity services and choose Properties from the context menu.
4. Change the startup type according to your requirements.

6. Optionally (or in case of problems) check the installer log in the PCo log directory: <INSTDIR>\Logs
\PCoInstallUtility <Date> <Time>.csv

6.3 Checking the Upgrade Installation

Procedure

Additional Steps

If you are carrying out an upgrade, you must perform the following additional steps:
1. Restartall agent instances that were stopped before the upgrade.

2. Optionally (or in case of problems) check the migration log in <INSTDIR>\Logs

\PCoMigrationUtility <Date> <Time>.csv.

OPC UA Source Systems

If you have OPC UA source systems and you upgraded from a release earlier than 15.0 to PCo 15.1, consider to
migrating them in accordance with SAP Note 1973693 .

With PCo Release 15.1 certificate handling during the creation of a connection to the OPC UA server has been
updated and corrected. This may cause certificate validation errors after the upgrade. To check whether this
applies to your installation, use the Test Connection button on the Session tab of your OPC UA source systems. If
the connection test fails, follow the instructions in the application help. For more information see Application Help
for PCo 15.1 on SAP Help Portal at help.sap.com/pco# | SAP Plant Connectivity » Source System » OPC Source
Systems » OPC UA Source System: Security Tab » Possible Causes of Connection Setup Failure 3.

6.4 Checking the Logging Parameters

PCo 15.0 and higher use Windows Event Logs for storing messages from the agent instances. A separate log
named SAP_<log number> is automatically created for each agent. Check whether the parameters of the log
suits to your needs.
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Procedure

1. Start the Management Console and navigate to the Log tab of each agent.

2. Choose Manage Log to open theWindows Event Viewerfor the log that is assigned to the agent instance.
3. Inthe Windows Event Viewer choose Properties from the context menu of the log.

4.

Define the storage location of the log, its maximum size and the action to be taken if the maximum size of the
log is reached.

1 Note

By default, the log for a PCo agent is created with an initial size of 4 MB, which is suitable for about 8000 log
entries. In case the maximum log size is reached, the oldest log entries will be overwritten.
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7 Additional Information

To allow remote communication between an agent instance in PCo OPC A&E (Alarms and Events), OPC DA, or
OPC HDA and an OPC A&E, OPC DA, or OPC HDA server respectively, you must correctly configure DCOM
security.

For more information, see www.opcfoundation.org # |+ Downloads » White Papers » OPC, DCOM and Security 3
and see thePlant Connectivity 15.1 Security Guide on the SAP Service Marketplace.

SAP Plant Connectivity is distributed with a self-extracting archive and contains SAP Setup to perform the
installation. For more information about the features of SAP Setup, see installation guide on SAP Service
Marketplace service.sap.com/sltoolset# under |» SL Toolset 1.0 » SAP Setup 1.
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8 Installing the Offline Help

PCo 15.1 offers you the possibility to access the Application Help even on computers without Internet access. To
make the PCo documentation available offline you can download the documentation files. The archive with the
offline documentation is available on SAP Service Marketplace.

Procedure

1. Download the pertaining archive by choosing |» Software Downloads » Installations and Upgrades » A-Z
Index » P » SAP Plant Connectivity » SAP Plant Connectivity 15.1 » Application Help (SAP Library) 3and
extract it.

2. Copy the HTMLHELP folder and all its content to a folder that can be accessed by all users on the computer
on which PCo is installed.

3. Openthe PCo Management Console and choose |» Tools » Options » Global Properties » Online Help 2 from
the menu. Configure the path to the offline documentation as explained on the Options screen for Online
Help.

1 Note

Note that there are restrictions for compiled Help Viewer files if these are located on network drives. You
may have to unblock the files in order to see the content.

CUSTOMER
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Typographic Conventions

Table 4

N

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

WWW.Sap.com e

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 A Hyperlink to an SAP Note, for example, SAP Note 123456
Example ®  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
®  Cross-references to other documentation or published works
Example ®  Qutput on the screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

Keys on the keyboard

Plant Connectivity 15.1
Typographic Conventions
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